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Introduction

QuickSteps books are recipe books for computer users. They
answer the question “How do I...?"” by providing quick sets
of steps to accomplish the most common tasks in a particular
operating system or application.

The sets of steps are the central focus of the book. QuickSteps
sidebars show how to quickly perform many small functions or
tasks that support primary functions. Notes, Tips, and Cautions
augment the steps, presented in a separate column so as not to
interrupt the flow of the steps. Introductions are minimal rather
than narrative, and numerous illustrations and figures, many
with callouts, support the steps.

QuickSteps books are organized by function and the tasks needed
to perform that function. Each function is a chapter. Each task,

or “How To,” contains the steps needed for accomplishing the
function with the relevant Notes, Tips, Cautions, and screenshots.
You can easily find the tasks you need through:

@ The Table of Contents, which lists the functional areas
(chapters) and tasks in the order they are presented

® A How To list of tasks on the opening page of each chapter

® The index, which provides an alphabetical list of the terms
that are used to describe the functions and tasks

® Color-coded tabs for each chapter or functional area with
an index to the tabs in the Contents at a Glance (just before
the Table of Contents)

viii Adobe Acrobat 7 QuickSteps ,

Conventions Used
in this Book

Adobe Acrobat 7 QuickSteps uses several conventions designed to make
the book easier for you to follow:

A (}l in the table of contents and in the How To list in each
chapter references a QuickSteps sidebar in a chapter, and a
#9 references a QuickFacts sidebar.

Bold type is used for words or objects on the screen that you
are to do something with—for example, “click the Start menu
and then click My Computer.”

Italic type is used for a word or phrase that is being defined or
otherwise deserves special emphasis.

Underlined type is used for text that you are to type from the
keyboard.

SMALL CAPITAL LETTERS are used for keys on the keyboard
such as ENTER and SHIFT.

When you are expected to enter a command, you are told to
press the key(s). If you are to enter text or numbers, you are
told to type them.
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Chapter 1

Stepping into Acrobat

Acrobat allows computer users to open and view files
created from a myriad of programs. Acrobat lets you convert
content from many disparate sources into a common file
format: a portable document format, or PDF. For example,
once your Word document, Excel spreadsheet, or InDesign
layout is converted to a PDF document, Acrobat provides

a plethora of tools and features that provide editing,
organizing, searching, linking, and collaborative functions.
To provide universal access to PDF documents, Adobe
offers a free program, Adobe Reader, so that anyone can
view a PDF file. Extending Acrobat’s reach, you can create
electronic forms that are tied to data collection engines; use
Distiller, a companion program that is normally used in the
background to create PDF files but can be used separately
to handle complex conversions; and perform preflighting—

a check of the document’s font, graphics, and other
characteristics to assure high-end printing requirements.

Adobe Acrobat 7 QuickSteps Stepping into Acrobat
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STARTING ACROBAT
IN DIFFERENT WAYS

In addition to using All Programs on the Start menu,
Acrobat can be started in several other ways.

USE THE START MENU

The icons of the programs you use most often are

displayed on the left side of the Start menu. If you

frequently use Acrobat, its icon will appear there, as

shown in Figure 1-1. To use this icon to start Acrobat:
1. Click Start. The Start menu opens.

2. Click the Acrobat icon on the left of the Start menu.

PIN ACROBAT TO THE TOP OF THE START MENU
If you think you may use other -
| E-mail
programs more frequently, you =
can keep Acrobat at the top e Acrobet 7.0
of the Start menu by “pinning” SRR
Open
it there. Run as...

s

1. Click Start to open the .m
Start menu. eyl hitves

2. Right-click (click the right mouse button) the
Acrobat icon, and click Pin To Start Menu.

USE A DESKTOP SHORTCUT
During installation, Acrobat ‘*T
automatically creates an icon L e
on the desktop that you can il
double-click to open Adobe Acrobat
the program. 7.0
Bithred... Professional

Adobe’Acrobat 7/QuickSteps Stepping into Acrobat

In this chapter you will familiarize yourself with Acrobat and
see how to start and leave it; use Acrobat’s windows, panes,
toolbars, and menus; learn how to navigate in a PDF; see
how to get help; and find out how to customize Acrobat.

. How You Start Acrobat

How you start Acrobat depends on how Acrobat was installed and what has

happened to it since its installation. In this section you'll see a surefire way to

start Acrobat and some alternatives. You'll also see how to leave Acrobat.

. Use All Programs to
Start Acrobat

If no other icons for or shortcuts
to Acrobat are available on your é Internet
desktop, you can always start

Acrobat using the All Programs 2| el

option on the Start menu. P aite Aercbat 7.0

Professional
1. Start your computer if it is not

already running, and log on to
Windows if necessary.

2. Click Start. The Start menu opens.

3. Click All Programs and click
Adobe Acrobat 7.0 Standard or
Adobe Acrobat 7.0 Professional,
whichever you have, as shown in
Figure 1-1.

Figure 1-1: The foolproof
way to start Acrobat is

through the Start menu. £3 start
Kl

| @

& Set Program Access and Defaults
& Windows Catalog

‘Windows Update
) Accessories »
) eBay Toolbar »
) Games »
) Hewlett-Packard » 1
[T) McAfee »
) Microsoft Office »
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) WebEx Recorder & Player 4
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STARTING ACROBAT
IN DIFFERENT WAYS (Continued)

USE THE QUICK LAUNCH TOOLBAR

The Quick Launch toolbar is a small area on the taskbar
next to the Start button. You can put an Acrobat icon on
the Quick Launch toolbar and use it to start Acrobat. If
your Quick Launch toolbar is not visible, open it and put
an Acrobat icon there.

Right-
click a
blank
area

of the taskbar, click Toolbars, and click Quick
Launch. The Quick Launch toolbar is displayed.

2. Click Start, click All Programs, and drag Adobe
Acrobat 7.0 Standard or Adobe Acrobat 7.0
Professional to where you want it on the Quick
Launch toolbar.

If you drag the Acrobat icon from the Start menu to the
Quick Launch toolbar and nothing happens, the toolbar
is probably locked. To unlock the toolbar, right-click a
blank area of taskbar, and click Lock The Taskbar on the

context menu to remove
the check mark. Properties I!! l

Leave Acrobat

To leave Acrobat when you are done using it:
® Click the File menu and click Exit.
—Or—
® Click Close on the right of the title bar. Q
—Or—

® Press CTRL+Q.

Explore Acrobat

Acrobat uses a wide assortment of windows, toolbars, menus, and special
features to accomplish its functions. Much of this book explores how to find
and use all of these items. In this section you’ll learn how to use the most
common features of the Acrobat window, including panes and windows that
can occupy the main window, the buttons on the principal toolbars, and the
menus.

Explore the Acrobat Window

The Acrobat window has many features to aid you in creating PDF files

and working with documents. The view presented to you when you open

a document is shown in Figure 1-2. The principal features of the Acrobat
window are introduced in Table 1-1 and will be described further in this and
other chapters of this book.

Adobe Acrobat 7 QuickSteps Stepping into Acrobat
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USING ACROBAT TOOLBARS

Toolbars hold buttons, or tools, that allow you to
perform a direct function, such as saving a file or rotating
a document. Some special tools contain menus of

additional options.

SEE WHAT A TOOL DOES

Hold the mouse pointer over the tool.
A Tooltip will appear telling you what T

the tool does.

USE A TOOL

Click the button or icon that represents the tool.

—Or—

Click the down arrow next to
a tool, and then click one of
the options in the menu that

appears.

DISPLAY A TOOLBAR
Right-click a toolbar and
then click the toolbar you
want displayed.

—Or-

Click the View menu,
click Toolbars, and
click the toolbar you
want displayed.

MOVE A TOOLBAR

® When the toolbar is docked

(placed in the toolbar area
below the menu bar), place
your pointer on the handle
on the left of the toolbar (the
column of dashes), and drag
it to the new location.

When the toolbar is floating
(see Figure 1-3), place your
pointer on the title bar of the

Advanced Editing

[ [Basic
Commenting
Drawing Markups
Edit

[v |
Find

[v]rel
Measuring
Navigation
Object Data

[ |Rotate view

[ |search the Internet

g

¥ zon
Properties Bar CrHE
Reset Toolbars Alt+F8
- Hide Toolbars F8

Lock Toolbars
Show Button Labels

toolbar, and drag it to the new location.

Continued...

TABLE 1-1: PRINCIPAL FEATURES OF THE ACROBAT WINDOW

ACROBAT FEATURES
Title bar

DESCRIPTION

Contains the name of the open document and the controls
for the window

Menu bar Contains the primary controls for Acrobat, divided
into categories

File toolbar Allows direct access to many of the document file functions
for Acrobat

Tasks toolbar Provides drop-down menus containing options for many of

the common tasks performed in Acrobat

Minimize button

Minimizes the window to an icon on the taskbar

Maximize button

Maximizes the window to fill the screen

Close

Exits Acrobat and closes the window

Navigation tabs

Provides quick access to several aspects of the
open document

Navigation pane

Displays contents of the selected Navigation tab

Document pane

Displays one or more pages of the open document

Document pane menu

Opens a menu of options related to the open document

Scroll arrow Moves the contents of the pane in the direction of the arrow
Scroll button Moves the contents of the pane in the direction it is dragged
Scroll bar Moves the contents of the pane in the direction it is clicked
Status bar Contains buttons and controls that enable you to change

the view of the open document

How To window

Displays categories of actions you can perform and links to
specific tasks

Window border

Sizes the window by being dragged

Control menu

Contains the controls for resizing, moving, and closing the
window itself

Adobe Acrobat 7 QuickSteps
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USING ACROBAT TOOLBARS
(Continued)
HIDE A TOOLBAR
1. Right-click any displayed toolbar or the menu bar.
2. In the context menu, click the toolbar to remove
the check mark.

HIDE ALL TOOLBARS

You can hide all open toolbars to quickly gain space
within the Acrobat window.

Click Hide Toolbars on the status bar. To display
the hidden toolbars, click the same

button again (now displayed as {=d
Show Toolbars).

To decrease the width of a toolbar, you can hide the
text labels that accompany many buttons. Right-click a
toolbar, click Show Button Labels at the bottom of the
context menu, and click No Labels.

Adobe Acrobat 7 QuickSteps Stepping into Acrobat

Use the Mouse

A mouse is any pointing device—including trackballs, pointing sticks, and
graphic tablets—with two or more buttons. This book assumes you are using
a two-button mouse. Moving the mouse moves the pointer on the screen. You
click an object on the screen by moving the pointer so that it is on top of the
object and then pressing the left button on the mouse.

You may control the mouse with either your left or right hand; therefore, the
buttons may be switched. (See Windows XP QuickSteps, published by McGraw-
Hill/Osborne, for information on how to switch the buttons.) This book
assumes the right hand controls the mouse and the left mouse button is “the
mouse button.” The right button is always called the “right mouse button.” If
you switch the buttons, you must change your interpretation of these phrases.

Figure 1-3: A toolbar can be docked in the toolbar area of the
Acrobat window, or it can be floating in or out of the window.

T e A R S S S A T )
T T B ) T cresePoF - | Comment SMerip v o SendforReview + (\Secue + Fson- — - WhE
Th select oy  ® - s S 0% - @ e e
| - - - o ] »
£ -~
i
\ 0
i { / December 2003
B
H ¥R The Role of the Prafiiasiiiii
dll O} Calout oo, Tool 4 Arrow Tool = | Dimensioning Tool 1% Show =
|
Obtaining a diagnosis is a team effort by the practitioner and pathologist
Practitioner
| 1. Provides the historv serves as the eves for the Jatholozist) in regard to gross Jesion:
- 2 Obtins the huzh quality samples for evaluas
| Pathologist
i R e M
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USING MENUS

OPEN A MENU WITH THE MOUSE
Click the menu name.

OPEN A MENU WITH THE KEYBOARD
Press ALT+ the underlined letter in the menu name (the
underlines appear after you press ALT). For example,
press ALT+F to open the File menu.

OPEN A SUBMENU
A number of menu options have a right-pointing arrow on
their right to indicate that a submenu is associated with
that option. To open the submenu:
Move the mouse pointer to the menu option with a
submenu, and the submenu will open.
SELECT A MENU OPTION
To select a menu option:
Click the menu to open it, and then click the option.

HIDE THE MENU BAR
Click the View menu and click Menu Bar.
-Or—
Press F9. (Press F9 again to redisplay the menu

The mouse pointer in Acrobat changes appearance
depending on the tool selected and the object it's placed
over. Outside the document pane, the pointer is typically the
Select arrow used to select commands and buttons. Inside
the document pane, the pointer appears as an I-beam when
working with text and a crosshair when using tools to

draw or select objects. The Hand tool pointer allows you to Q‘r?

browse a document using your mouse (see “Use Acrobat
Navigation” later in this chapter).

e

Five actions can be accomplished with the mouse:

® Point at an object on the screen (a button, an icon, a menu or one of its options, or a

border) to highlight it. To point means to move the mouse so that the tip of the pointer

is on top of the object.

Click an object on the screen to select it, making that object the item that your next
actions will affect. Clicking will also open a menu, select a menu option, or activate a
button or “tool” on a toolbar. Click means to point at an object you want to select and
quickly press and release the left mouse button.

Double-click an object to open or activate it. Double-click means to point at an
object you want to select, then press and release the left mouse button twice in

rapid succession.

Right-click an object to open a context
menu containing commands used to ma-
nipulate that object. Right-click means to
point at an object you want to select and
then quickly press and release the right
mouse button. For example, right-clicking
selected text opens the context menu on
the right.

Drag an object to move it on the screen
to where you want it moved within the
document. Drag means to point at an
object you want to move and then press
and hold the left mouse button while
moving the mouse. The object is dragged
as you move the mouse. When the
object is where you want it, release the
mouse button.

== Copy To Clipboard Chrl+C

= Copy As Table
ﬁ Save As Table...
@ Open Table in Spreadshest

Select All Chrl+a
Deselect all Shift+Ctrl+a

Replace Text (Comment)
Highlight Text (Comment)
Add Note to Text (Comment)
Underline Text {Comment)

Cross Out Text (Comment)

Add Bookmark. Ctrl+B

Create Link

Lookup "effort"

Adobe Acrobat 7 QuickSteps Stepping into Acrobat
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UNDERSTANDING THE
PDF CONCEPT

One of the great frustrations of computing is receiving a
document or picture and not being able to view or print
it because you have neither the program that created
it nor a program to adequately convert it. Windows
promised us this valuable, integrated environment, but
in practice, how we exchange information is still very
program-parochial. Acrobat, in blood-type terminology,
acts as a universal recipient, accepting many file and
graphics formats for conversion to its PDF file format—
and what a conversion it is! Converted documents and
web pages appear exactly as they did in their source
formats. Once a document is converted to a PDF file
in Acrobat, a myriad of features and benefits can be
universally applied. For example, using Acrobat you can:
® Combine several documents into a single PDF

® Reduce the file size associated with documents
by selecting one of several PDF file compression
levels

® Distribute a PDF among several reviewers and
use commenting and marking tools

® Navigate within larger PDF documents using sev-
eral techniques (see “Use Acrobat Navigation” in
this chapter)

® Create tables of contents and indexes

® Provide document security using encryption and
digital signatures

® Create electronic forms (Adobe Reader can be
used to fill out the forms)

If you need to make any significant changes to the content |
of the PDF, you are better off doing the work in the original
program, saving the file, and reconverting the file to a PDF.

Use Acrobat Navigation

One of the key elements of working with documents, especially lengthy ones,
is being able to quickly move to where you want to perform a task. Acrobat
provides several tools and techniques to allow you to get to where you want,
and provide assistance to others viewing your documents.

USE THE NAVIGATION PANE

The navigation pane (see Figure 1-2) provides tabs that categorize many of the
elements found in a PDEF, allowing you to quickly focus in on the information
you want. To display tabs that don’t appear on the left edge of the navigation
pane, click View, click Navigation Tabs, and click the tab you want from the
submenu.

Some of the tabs appear in their own window and are not docked along the left
edge of the navigation pane. To dock an open tab, click View, click Navigation
Tabs, and click Dock All Tabs.

The tabs that provide additional navigation properties include:

® Bookmarks allow you to quickly jump to
specific areas or objects in a document
or perform an action, such as open-
ing a page view. Bookmarks can be
created from a table of contents, but
they can also be created by selecting
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